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 What’s New in Adobe InDesign CS4
In the transition between CS3 and CS4 we see a 
substantial shift in the interface as well as a change 
in the way we create adjustment layers.  Most new 
features are additions to existing functionality.

Compatibility Issues
To open an InDesign CS4 document into CS3, we 
must export the document to the InDesign CS3 In-
terchange format (INX). Content may be modified 
or omitted when we open a file in InDesign CS3. 

Also, we need to make sure that the computer 
running InDesign CS3 has been updated with the 
necessary plug-ins so that it can open the exported 
INX file. To do this, go to Help > Updates and fol-
low the prompts or go to the InDesign downloads 
page on the Adobe web site.

To export a CS4 document to the INX format, 
follow these steps:

1.	 From the Menu bar, choose File > Export.

2.	 From the File type (Windows) or Format 
(Mac) menu, choose InDesign CS3 Exchange.

3.	 Click Save.

If we want to open an InDesign CS4 document into 
CS2, then we will need to open the file in CS3 and 
export the file again to INX.

Interface Changes
The most noticeable interface change in CS4 is the 
removal of the Title Bar that is ubiquitous across all 
other Windows applications.  Now, the Menu bar is 
at the very top of the application.

The default interface has also changed.  Initially, we 
see are fewer panels on the right side of the screen 
in previous versions of InDesign. We may customize 
our workspace to show more if we want.

Customizing the Interface
One of the unique things about Adobe products is 
the malleable interface.  We can adjust the interface 
to our own style and comfort and save it, or we can 
use several pre-set interfaces built into each InDe-
sign. These Workspaces are designed for specific 
functionalities of the program such as Web, or 
Color and Tone. The default workspace of CS4 is 
called “Essentials”.  This displays the toolbar as it 
was in previous versions, but it reduces the number 
of Panels on the right side. In the Options bar at the 
top right, there is a drop down menu called “Essen-
tials”.  This is the menu of default Workspaces that 
are available to us in CS4. We can create our own as 
well.
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Designing the Interface to Look Like a CS3 

Display
If we want to make the interface a bit more com-
fortable for ourselves as seasoned CS3 users, we can 
do that.  Here we’ll show you how, and then we will 
point out some useful new features of InDesign 
CS4.  

In order to change the interface, we should do so 
from the right side of the Menu bar, where we see 
by default a drop-down that says, “Essentials.” This 
is the Workspace Switcher. Click Essentials, and 
then click Advanced. This interface arranges the 
panel groups in the following order: Pages, Links, 
Layers, Stroke, Swatches, Gradient, Object Styles, 
Effects, Paragraph Styles, and Characters Styles. It 
attaches them vertically in a set of docked panels. 
We can collapse and expand these groups to give 
more space to other panel groups. We can also close 
any of these groups by clicking the panel options 
menu, and click “Close Group.” 

Now that we are working with the Advanced 
Workspace, to make our panels as close to CS3 as 
possible, in the Menu bar, go to the Windows menu 
and open the Info and Color panels. Then, under 
the Windows menu item, choose Type & Tables 
and select Character, Paragraph, Table Styles, Cell 
Styles, and Table. 

At this point, we can go back to the Workspace 
Switcher at the top that says “Advanced,” and 
choose New Workspace. Decide on a name for 
this workspace, for example, “CS3.” When we have 
finished, we have saved this workspace setting; from 
now on, on the local computer, it will appear at the 
top of this drop down menu. At any time we also 
select our own custom Workspace and it will display 
our personally set preferences.

As we can see, there are many options under this 
workspace menu for different tasks. We can alter 

these preexisting menus to our own convenience 
and create completely new workspaces and save 
them as needed.

Additional User Interface  
Enhancements
In CS3, multiple documents had to be opened in 
order to copy and paste objects or text between 
documents. In CS4, artboards and different views 
allow multiple documents to be open at once but 
they function as a set of tabbed documents. This 
gives the user a lot of flexibility for copying, pasting, 
dragging and simply comparing two separate files.

Some better examples of usability are: 

•	 Tabbed documents for easier movement be-
tween documents.  

•	 N-up View, which allows us to view multiple 
documents at the same time so that we can 
compare and drag content between them. To do 
this go to the Arrange Documents drop down 
menu on the top Menu bar. It is to the left of 
the drop down workspace menu.

•	 More nudge buttons so that we can use the up/
down arrows to change Character/Paragraph 
Styles and other values.

•	 Mouse scroll wheel support allows navigation 
through pages with the mouse scroll wheel. 
Holding the mouse at the top or bottom of the 
page makes it scroll faster.

•	 Power zoom allows us to use our mouse to 
zoom in/out by holding down the button. 
Moving the mouse while we continue to hold 
changes our point of view.
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Productivity  
Enhancements
InDesign CS4 offers many productivity enhance-
ments such as real-time preflight error indicators, 
spread view, cursor enhancements, and more.

Smart Views
InDesign CS4 lets us display so much more in-
formation as we work. Following are several new 
features.

Live Preflight
Live Preflight shows us at a glance when we have 
errors that would prevent successful offset printing. 
The Live Preflight panel can be opened two ways. 
On the bottom left of the document we see a green 
or red icon that says, “No errors” or “errors,” respec-
tively. To the right of the icon is an arrow, which 
when clicked reveals a link to the Preflight panel as 
well as the option to uncheck “Preflight Document,” 
which turns live preflight off. Another way to get to 
the Preflight menu is to go to Window, Output, and 
Preflight. With that, Preflight will now be done in 
real time as we work, unless turned off. The benefit 
of this is to avoid surprises later and to correct as we 
go. This can help save time and prevent costly print-
ing mistakes. We can save preflight profiles, embed 
them, determine what mistakes will raise the alarm, 
and our printer can import their standard profile to 
us. 

Spread View Rotation
In the Pages panel (Window, Pages), by simply 
right-clicking on a page icon and selecting “Rotate 
Spread View,” it is possible to rotate the spread view. 
This applies is the entire spread. Therefore, it is now 

possible to automate our view of the document from 
all angles. InDesign will save our file in rotated view 
until we retrace our steps and choose “Clear Rota-
tion.”

Smart Guides, Smart Dimensions, Smart Cursors, 

and Smart Spacing
Now, InDesign automatically senses where things 
are located by the x and y coordinates. When we 
create or alter an object, the Smart Guides display 
the height and width of the object. In addition this 
feature will show us the dimensions of the selected 
object in relation to other objects on the page, to 
help with accurate spacing.  To turn off Smart 
Guides, from the Menu bar, click View, Grids and 
Guides. To turn off Smart Cursors, from the Menu 
bar click Edit, Preferences…, then click Interface. 
Unclick Show Transformation Values. To turn off 
smart dimensions and/or spacing, do the same 
except find it under Guides and Pasteboard.

New Panels
There are several new panels in InDesign CS4. 
Moreover, the many of the old panels have a new 
look.

Links Panel
It is now possible to see link information such as 
scale, rotation and resolution easily. We can also re-
pair damaged links right within the panel by linking 
to a new folder.

Pages Panel
Different organizations and size views of pages in 
the Pages panel are now possible by clicking on the 
Options button on the top right of the Pages panel, 
and then choosing Panel Options.
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Quick Guide Deletion
We can now easily delete all guides by right-clicking 
(or Ctrl-clicking for Mac) on the rulers and choos-
ing Delete All Guides.

Ruler Origin
The Ruler origin can now be placed on the spine of 
our document (when we use facing pages) so that 
left pages have negative x values and right pages 
have positive values.

Leading-based baseline grid increments
Even if we specify a different measurement for 
Units and Increments such as inches, the Grid still 
uses points to match text size and leading.

Slug area enhancements
When we move pages, the objects in the slug and 
bleed area move with us; also, page numbers in the 
slug area now display an actual number.

Additional User 
Functions
With global textual tools and drawing and graphics 
improvements, we can do a lot more in CS4. For 
example, we can super-power textual Find and Re-
place sequences, handle graphics better, and create 
interactive documents. 

Global Textual Tools
There are a number of additional improvements in 
the way we handle text and tables. 

Conditions for Text

We can now use conditional text to create different 
versions of the same document for different condi-
tions (such as the UK and USA) within the same 
file. In the past, two separate files would have had 
to have been created.  The conditional text menu 
can be reached from the Menu bar by Clicking 
Windows, then Type and Tables, and Conditional 
Text. We can set up layers within this panel and 
then highlight text and select which condition layer 
it should belong to within the panel. Or we can 
automate the document to always put text with a 
certain element into a certain conditional layer. An 
example of this would be that any text that contains 
the sign for the British pound would automatically 
put that sign and the following numbers into the 
UK conditional layer. To do this, we must go to 
the Edit menu on the Menu bar and choose Find/
Change. In that menu, choose the GREP tab, and 
then in the “Find what” field, type the $ symbol and 
then click on the @ button to the right. We also 
need to automate the numbers that come after the 
dollar sign, so under Wild cards, choose any digit. 
Then under the same @ menu, under Repeat, choose 
one or more times. The last step is to signify which 
condition these rules should apply to. In the change 
format field, click on the magnifying button and 
click on condition to the right. Then on the left, we 
can choose for which conditional layer these rules 
apply. Finally, click on Change All.

Smart Text Reflow
InDesign will now add or remove pages as we type, 
anticipating the space needed rather than having 
text overflow. We can also turn on the Autocorrect 
misspelling list in order to edit as we go. To do that, 
from the Menu bar, choose Edit, Preferences, Type 
(Windows) or else InDesign, Preferences, Type 
(Mac OS). Select Smart Text Reflow. Choose any of 
the options and then click OK.
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default to the original program it was created in. 

Constrained Placement of Graphics
With a Placed object loaded into the cursor, when 
we draw a frame, that the frame draws to the pro-
portion of the object. It literally frames and con-
strains the object.

Placing Multiple Graphics as a Contact Sheet
We can place multiple images at once in a grid form 
by holding down Ctrl+Shift or Command+Shift 
(Mac OS). We can use the arrow keys to control the 
number or rows and columns of the images.

Multiple Artboard Placement
It is now possible to choose a page to place from an 
Illustrator file containing multiple artboards, and 
to place a single page or a range of pages from a 
multipage PDF file.

Pathfinder Panel Buttons
Now, in one step, we can join paths, open paths 
or reverse paths. To use this, from the Menu bar, 
choose Windows, Object and Layer, then Path-
finder. Different available buttons adjust objects and 
their paths. One of the buttons uses intersecting 
paths to create a new shape within shapes. This new 
shape will then be treated as a new object and then, 
for example, a new color could be chosen.

Text Stroke Control
We can now adjust the Stroke alignment, Stroke 
cap, End join, etc., on text without having to first 
convert it to outlines. These options are also avail-
able as Styles.

Nested Line Styles using GREP
We can format individual lines of text to have 
different styles (such as fonts and colors). Rather 
than basing styles on sequence or header and body, 
GREP is a pattern-based search technique that 
allows for a different organization based on content 
or other criteria. By using GREP we can also apply 
certain styles to an element within the paragraph—
even one that repeats through a document. For ex-
ample, we can make every letter O appear italicized 
and purple. 

Let’s try an example. To use the GREP feature to 
italicize and re-color every O, first select the text 
box with the Selection tool. Go to the Menu bar, 
choose Edit, then Find/Change, click GREP, and 
under “Find What,” type the letter O. Then, at the 
bottom under Change Format click the Zoom 
(magnifying glass) icon, and in the pop-up box, go 
to Basic Character Formats, then Character Color 
to Change. Then click OK. The dialog closes. At this 
point, in the previous box, click Find. Make sure 
the change is the desired one by finding the first 
instance. When satisfied that GREP will work cor-
rectly, click Change All, and then click OK. When 
working with a large document, GREP Styles are a 
great way to make this type of global change easier. 
For example, we can have a character style applied 
to all numbers in a document. Or, we can have all 
paragraphs containing specific information show as 
one style. 

Graphics and Drawing  
Improvements 

Edit Origin Flexibility   
Now we can use the Edit With… command to 
choose which program to edit an original artwork/
placed item, rather than letting the operating system 
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Redesigned Hyperlinks Panel
We can now verify our hyperlinks directly in InDe-
sign before we export into an interactive file format. 
The Hyperlinks panel is under Window/Interactive/
Hyperlinks.

Extensive Integration
We can export an InDesign document to Flash as 
a SWF or XFL file. We can also export as a PDF 
for some interactivity; this is particularly useful for 
presentations. These functions are all integrated with 
Adobe Bridge. In addition, Adobe has a plethora of 
services that a few power users may take advantage 
of, such as: Community Help, ConnectNow (which 
we can use to connect with clients instead of e-mail 
or a telephone) and the Kuler panel, which lets us 
experiment with color combinations and share color 
schemes with the rest of the online Kuler commu-
nity.

More Information
To find more training and information about InDe-
sign, go to: http://ittraining.iu.edu/indesign.

Free Transform Tool Improvements
This tool is much easier to use and more intuitive, 
with larger hit zones. In addition, we can resize 
around object edges.

Interactivity Features
InDesign can be used to create interactive electronic 
documents.

Page Transitions in PDF and SWF Files
We can change the style of page transition when we 
are digitally turning pages; different transitions to 
different pages or one style of transition to groups 
or all pages. This is possible through the Pages panel.

Enhanced Buttons
We can create interactive buttons or select preexist-
ing buttons that will then perform and action when 
converted to a SWF or PDF. In InDesign we can 
now design a button that specifies the event (such as 
a mouse click) and choose what will happen because 
of that event (e.g., a specific sound). Then, when 
exported to the correct interactive file format, it will 
perform accordingly. This is all possible through the 
Buttons panel.


